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FEDERAL ACCESSIBILITY REQUIREMENT 
Federal law requires instructional materials to be accessible to students with disabilities. These 
requirements are based on the Americans with Disabilities Act (ADA), Section 504 of the 
Rehabilitation Act, and the Web Content Accessibility Guidelines (WCAG). 

These requirements apply to all courses, including face-to-face courses, hybrid courses, and 
online courses. Any materials provided to students must be accessible, including documents, 
slides, videos, images, or LMS pages. This includes everyday course communication and support 
materials such as handouts, emails, announcements, flyers, webpages, advising documents, 
and presentations, not only materials posted in the LMS. 

IMPLEMENTATION TIMELINE 
The federal deadline is April 24, 2026. As an instrumentality of the State of Oklahoma, Seminole 
State College must meet the federal deadline for large public entities. Digital course materials 
and web content should meet WCAG 2.1 AA standards by that date. 

Compliance for Classes Currently in Session: The DOJ exception for pre-existing documents 
does not apply to materials students still need in order to participate in or benefit from an 
active course. 

The "Forward-Facing" Triage Strategy: 

• Priority 1 (Required Materials): Remediate the syllabus, rubrics, and all materials
students need for the remaining weeks of the semester.

• Priority 2 (High-Utility References): Update any documents students must revisit for
cumulative exams, final projects, or major end-of-term assignments.

• Priority 3 (LMS Structure): Ensure module headings, navigation, descriptive links, and
key images meet accessibility standards.

• Archive Exception: Materials used earlier in the semester that students no longer need
for course completion may remain as-is until the course is revised.

ACCESSIBILITY AND UNIVERSAL DESIGN FOR LEARNING (UDL) 
UDL reflects good teaching practice by encouraging instructors to design courses that support a 
wide range of learners by providing multiple ways to access information, multiple ways to 
demonstrate learning, and clear and organized course materials. 

This guide focuses specifically on legal accessibility requirements for students using assistive 
technologies. Many accessibility practices also support UDL by improving usability for all 
students, such as captions, alt-text, and clear structure. 

Video Tutorials: I recommend the Massachusetts Office on Disability’s series on “Creating 
Digital Documents.” 

From Reactive Accommodation to Proactive Accessibility: The fundamental goal of the ADA 
Title II mandate is a shift in architecture: moving from Reactive Accommodation (fixing a barrier 
only after a student identifies a need) to Proactive Accessibility (building the "digital ramp" into 
the course blueprint from day one). 

https://youtube.com/playlist?list=PLsiz0GxiqA2f88B5u9B6uqHDsP3ArEYgK&si=yg_YHlMpMddo8odN
https://youtube.com/playlist?list=PLsiz0GxiqA2f88B5u9B6uqHDsP3ArEYgK&si=yg_YHlMpMddo8odN
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The "Baseline" vs. The "Individual": The Baseline (WCAG 2.1 AA) is the "building code." By 
meeting these standards, we automatically address the most common barriers for visual, 
auditory, motor, and cognitive disabilities (seen or unseen). Individualized accommodations 
(e.g., sign language interpreters) will still be coordinated through the campus disability services 
office for specific needs that exceed the universal baseline. 

High-Impact Design: Universal Design for Learning (UDL) assumes that disability is part of the 
natural diversity of any classroom. Focus on eliminating these common barriers to help the 
widest range of students: 

Barrier Category The Proactive Fix (WCAG 2.1) Who it helps 
Visual Heading Styles (H1, H2) and Alt-

Text. 
Screen reader users and students on 
mobile devices. 

Auditory Closed Captions and transcripts. Students with hearing loss and non-
native speakers. 

Motor Keyboard Navigable (no "click 
here" links). 

Users with limited mobility or those 
without a mouse. 

Cognitive Consistent Navigation and clear 
formatting. 

Students with ADHD, dyslexia, or 
high stress. 

The "+1 Strategy" for Instructional Design: Full compliance can feel overwhelming. The 
+1 Strategy, popularized by Tobin and Behling within UDL practices, is the most effective 
way to handle the "unforeseeable" without burnout: 

• One More Way to See it: If you have a text-heavy module, add one video or infographic.
• One More Way to Do it: Offer one alternative format for a traditional assignment (like a 

podcast or video essay).
o Note for Writing Courses: In a composition class where "the essay" is the objective, 

an alternative format does not mean less writing. To preserve learning outcomes, 
require a formal, written script or a full transcript for any audio/visual project. This 
allows you to still grade the student's mastery of argumentation, logical structure, 
and MLA 9th Edition citations, while removing the barrier of the linear, typed essay 
format.

• One More Way to Connect: Offer one alternative to a live discussion, such as an 
asynchronous discussion board or a recorded reflection. 

Key Takeaway: We are no longer designing for the "average" student; we are designing for the 
variability of students. By meeting these standards, we remove the "hidden tax" on students 
who previously had to self-identify and wait for a retrofit. They can now simply show up and 
start learning. 
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START HERE: SIX ACCESSIBILITY PRACTICES 
If you follow these six practices, your materials will meet most accessibility expectations. 

1. Use heading styles instead of manually formatting headings 
2. Avoid scanned PDFs; use searchable text 
3. Add alt-text to images 
4. Ensure videos include captions 
5. Use descriptive links instead of “click here.” For example, use descriptive link text such 

as “Microsoft Accessibility Assistant Instructions” instead of “click here.” 
6. Provide written instructions, not only screenshots, diagrams, images, or videos 

ACCESSIBILITY TOOLS AVAILABLE TO FACULTY 
Most accessibility improvements can be completed using tools already available through SSC. 
See Appendix E for links. 

1. Microsoft Office Accessibility Checker: Most Microsoft Office applications include a 
built-in accessibility checker. This tool identifies issues such as missing alt-text, 
document structure problems, table formatting issues, color contrast concerns. To run 
the checker go to Review > Check Accessibility.   

2. Adobe Acrobat: Adobe Acrobat can convert scanned PDFs into readable text and check 
document accessibility.   

3. Microsoft Teams / Stream: Recordings automatically generate captions and transcripts.   
4. Zoom: Cloud recordings can generate captions and transcripts.   
5. YouTube: Videos uploaded to YouTube automatically generate editable captions.   

FONTS AND READABILITY 
Use readable sans-serif fonts such as Arial, Calibri, Lato, or Verdana for most text. Serif fonts 
such as Times New Roman are harder to read on screens, so reserve them for headings or short 
captions. Body text should usually be about 12–14 point or an equivalent readable size. 
Accessibility depends on readability, structure, and contrast rather than exact font size. Avoid 
decorative fonts. 

Technical Contrast Ratio: This measures the difference in brightness between text or an object 
and its background. The higher the ratio, the easier the content is to read and see. In practical 
terms, this usually means using dark text on a light background or light text on a dark 
background and avoiding faint colors or low-contrast design choices. To ensure readability for 
all users, follow these specific WCAG 2.1 ratios: 

• Standard Text: Minimum 4.5:1 contrast ratio. 
• Large Text (18pt+ or 14pt bold): Minimum 3:1 ratio. 
• Icons/Graphics: Minimum 3:1 ratio. 
• Use an online contrast checker if you are unsure about custom colors or flyers such as 

WebAIM: Contrast Checker 

https://webaim.org/resources/contrastchecker/?utm_source
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IMAGES AND ALT-TEXT 
Alt-text should be concise and provide the same information to a non-visual user that a sighted 
user would gain from the image. 

• Instructional Context: Describe what the student needs to know for the assignment or 
lesson. 

• Decorative Images: Mark images as decorative if they add no instructional value. 
• Complex Visuals: For charts, maps, and other detailed visuals, provide a short alt-text 

summary and a fuller explanation in the surrounding text. 

See Appendix D for detailed remediation examples of fine art, historical photographs, and 
charts. 

ACCESSIBILITY CHECKLIST 
Use this final quality check before posting course materials. 

Category Requirement Check 

Text Used built-in Heading Styles (H1, H2, H3) in logical order. ☐ 

Color Text meets contrast ratios (4.5:1 for normal text; 3:1 for large text). ☐ 

Color No information is conveyed by color alone. ☐ 

Images All meaningful images have descriptive alt-text. ☐ 

Links Links are descriptive (for example, “Assignment 1 PDF”), not “click 
here.” 

☐ 

Tables Tables have a designated header row and no merged cells. ☐ 

Media Videos have accurate captions; audio-only files have transcripts. ☐ 

Navigation The document or page can be navigated using only the Tab key. ☐ 

STEM Equations are created with Math Editor or MathType, not screenshots. ☐ 

ACCESSIBILITY FOR POWERPOINT SLIDES 1 

PowerPoint slides are accessible when they follow basic structure. Use built-in slide layouts 
rather than manually placing text boxes. Include a clear slide title, readable fonts, alt-text for 
images, and good color contrast. These same practices also apply to committee presentations, 
workshops, student orientations, recruiting events, and departmental presentations. Run the 
accessibility checker: Review > Check Accessibility. 2   

1See Appendix C for specialized instructions on creating accessible Chemistry equations in PowerPoint. 
2 See Appendix E for links to instructions and tutorials on accessibility with specific programs. 
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Reading Order: The "Selection Pane" Logic: PowerPoint reads objects in the order they were 
created, which is usually the opposite of how we want them read. You can fix this by following 
these steps: 

• Open the Pane: Go to Home > Arrange > Selection Pane. 
• The "Reverse" Rule: Screen readers read from the bottom of the list to the top. The 

Correct Order: 
o Bottom of List: The Slide Title (read first). 
o Middle of List: Your instructional text and equations in logical order. 
o Top of List: The final "Correct Answer" or "Next Steps" box (read last). 

• Why It Matters: If the Title is at the top of the Selection Pane list, the screen reader will 
read the entire slide first and only announce the Title at the very end. 

ACCESSIBILITY FOR SPREADSHEETS (EXCEL) 
Spreadsheets should be organized clearly.   

• Use Header Rows and label columns clearly.   
o Example: | Student Name | Exam 1 | Exam 2 | Final Grade | 

• Avoid Blank Rows: Large blank spaces can interrupt reading order. 
• Use Clear Labels. Example: 

o Poor: HW1 / HW2 / HW3 
o Better: Homework 1 / Homework 2 / Homework 3 

• Run the accessibility checker: Review > Check Accessibility. 3   

ACCESSIBILITY FOR MATH, SCIENCE, AND BUSINESS COURSES 
(Courses Using Equations, Graphs, Charts, or Data Visualizations) 

The Golden Rule for Equations: No Screenshots: To be accessible to screen readers, 
mathematical and chemical equations must be live text rather than images. 

• Method: Use the Brightspace Math Editor (LaTeX/MathML) or the MathType plug-in for 
Word and PowerPoint. 

• Avoid: Never use the Snipping Tool or screenshots to paste an equation as an image. 
• Context: If a complex molecular structure or technical visual is used, provide a brief text 

explanation of the key relationships, bond types, trends, or results in the surrounding 
lesson text. 4 

3 See Appendix E for link to Excel instructions on accessibility 
4 Platform-specific instructions for chemistry remain in Appendix C. 
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VIDEO AND AUDIO ACCESSIBILITY 
Instructional videos must include captions. Many platforms generate captions automatically. 
Teams/Stream, Zoom, and YouTube all provide automatic captioning tools, though captions 
should still be reviewed for accuracy. 5 Audio-only recordings should include a transcript. 

Audio-only recordings should include a written transcript. 

Audio Description (AD): For videos that include meaningful visual information not conveyed 
through speech (e.g., a silent lab demonstration or a chart shown without narration), you must 
provide Audio Description. This can be a second audio track narrating the action or a descriptive 
text transcript that includes both dialogue and visual descriptions. 

MAKING SCANNED PDFS ACCESSIBLE 
Scanned PDFs are usually images of pages that screen readers cannot read. To fix this: 

• Open the file in Adobe Acrobat 
• Select Scan & OCR > In This File > All Pages > Recognize Text 
• Save the document 6 

ADVANCED INSTITUTIONAL STANDARDS 
• Procurement: Before adopting new third-party tools, software, or digital textbooks, 

request a VPAT (Voluntary Product Accessibility Template) or ACR (Accessibility 
Conformance Report). 7 

• Social Media: Departmental accounts should use CamelCase hashtags (for example, 
#CollegeSuccess) and the platform’s built-in alt-text tools for image posts. 

• Fundamental Alteration: If making a specific material accessible would fundamentally 
change the learning objective, document the reason and provide an equitable 
alternative. 

WHAT FACULTY ACTUALLY NEED TO KNOW 
The upcoming ADA Title II deadline does not require you to rebuild every course you have ever 
taught from scratch. However, it does require that any materials students are actively using are 
accessible by the compliance date. The most important takeaway: April 24, 2026, is the 
compliance deadline, not the start date for making improvements. 

The “Active Content” Rule: If a student uses a resource to access, participate in, or complete 
your course, it should be accessible. This includes: 

• Documents: Clear structure and readable text 
• Visuals: Alt-text for meaningful images 
• Media: Accurate captions for videos and transcripts for audio-only materials 

5 See Appendix E for links to tutorials and instructions for accessibility. 
6 See Appendix E for link to OCR tutorial. 
7 See Appendix E for links to VPAT and ACR accessibility information. 
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Bottom line: If you are teaching with it on or after the deadline, treat it as current content and 
make it accessible. 

Understanding the Limited Exceptions: The DOJ provides two distinct, narrow exceptions for 
older content. 

• Archived Web Content: This applies to content that is truly frozen in time. To qualify, 
the content must meet all four of these conditions: 

o It was created before the compliance date 
o It is kept only for reference, research, or recordkeeping 
o It has not been changed since archiving 
o It is stored in a clearly designated archived area 

• Preexisting Conventional Electronic Documents: This applies to older PDFs, Word 
documents, PowerPoints, or spreadsheets posted before the compliance date. 

o Important limitation: This exception does not apply if the documents are 
currently being used to provide access to the college’s programs, services, or 
activities. 

o In practice: If you pull an old PDF or slide deck into a current course, treat it as 
active instructional content and make it accessible. 

Accessibility vs. Accommodations: These are related but different responsibilities: 

• Accessibility (proactive): The work you do in advance for the whole class 
• Accommodations (individualized): Supports or adjustments needed to ensure equal 

access for a specific student 

Even if some older content may qualify for an exception, the college still has an ongoing duty to 
provide effective communication and individualized action when needed to ensure equal 
access. 

What This Means for You Right Now 
• Prioritize active materials. Focus on the materials you are using in current and upcoming 

courses. 
• Build new materials accessibly from the start. New content created after the deadline 

does not qualify for preexisting exceptions. 
• Audit older PDFs. Make sure they contain actual readable text, not just scanned images. 
• Ask when you are unsure. The exceptions are narrow and fact-specific. If you are unsure 

whether something counts as archived or active, check with the college’s accessibility or 
legal office. 

MANUAL CHECKS THE ACCESSIBILITY CHECKER WILL MISS 
Automated checkers only catch about 30–40% of errors. Perform these manual checks: 

• The Tab Test: Can you navigate the entire document/page using only the Tab key? 
• The No-Color Test: If you view the document in grayscale, is the information still clear? 
• The Reading Order Test: In PowerPoint, use the Selection Pane to ensure a screen 

reader will read the slide elements in the correct logical order. 
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FINAL REMINDER 
Accessibility improvements usually involve small formatting changes, not rebuilding your 
course. Improving materials gradually each semester will ensure courses meet accessibility 
requirements while keeping the workload manageable. 
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APPENDIX A 

HOW TO CREATE A COMPLIANT TABLE 
Follow these steps when creating any table in Word, Excel, or your LMS. Video Tutorial at 
Creating Accessible Tables (Module 3, Lesson 4) 

1. Use Tables Only For Data: Tables should organize data, not control layout. Do not use 
tables to position text or images. Use tables only when information is best shown in 
rows and columns 

2. Add A Header Row: The first row must clearly identify each column.   
a. Example: | Student Name | Exam 1 | Exam 2 | Final Grade | 
b. In Microsoft Word or Microsoft Excel: Select the top row then mark it as a 

Header Row. Screen readers use this row to understand the table. 
3. Keep The Structure Simple: 

a. Avoid merged or split cells 
b. Keep a consistent number of columns in each row 
c. Do not leave blank rows or columns inside the table 
d. Simple tables are easier for assistive technology to read. 

4. Use Clear Labels: Avoid abbreviations that are unclear. 
a. Poor: HW1 | HW2 | HW3 
b. Better: Homework 1 | Homework 2 | Homework 3 
c. Labels should make sense when read aloud. 

5. Add A Table Title Or Context: Introduce the table with a short sentence. 
a. Example: “The table below shows student exam scores for the semester.”   
b. This helps students understand what the table represents. 

6. Check Reading Order: Screen readers read tables from left to right, top to bottom. 
Make sure the most important information is not buried and the order makes sense 
when read aloud. 

7. Run The Accessibility Checker: Before posting in Word or Excel: Review > Check 
Accessibility. Fix any issues related to missing headers and structure problems   

QUICK CHECK 
Before uploading your table, confirm: 

• Table is used for data (not layout) 
• Header row is included 
• No merged or split cells 
• Labels are clear and descriptive 
• No blank rows or columns 
• Table makes sense when read aloud 

Key Takeaway: A table is accessible when a student using a screen reader can understand what 
the table is about, what each column represents, how the data is organized, and if the structure 
is clear and simple, the table will be accessible.   

https://youtu.be/Y5rUaDL-IDc?si=FpuO-S1DDGc3LOiH
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APPENDIX B 

USING CHATGPT TO SUPPORT ACCESSIBLE MATERIALS 
ChatGPT can help faculty create materials that meet accessibility expectations by improving 
structure, clarity, and organization. It does not replace accessibility tools but can make it faster 
and easier to prepare accessible content. 

WHAT CHATGPT CAN HELP WITH 
• Improve Document Structure: ChatGPT can organize content using headings (H1, H2, 

H3), bullet points and lists, and clear sections. This improves navigation for screen 
readers. 

• Simplify And Clarify Language: ChatGPT can rewrite complex or dense text, improve 
readability, and reduce unnecessary jargon. Clear writing benefits all students, including 
those using assistive technology. 

• Generate Alt-Text For Images: ChatGPT can draft alt-text based on a description of the 
image. Faculty should review for accuracy and ensure the description reflects what 
students need to learn 

• Create Accessible Tables: ChatGPT can suggest clear column headers, simplify table 
structure, and improve labels. Tables should still be checked in Word or Excel. 

• Write Clear Instructions: ChatGPT can convert instructions into step-by-step directions, 
numbered lists, and clear, concise language. This ensures instructions are available in 
text form, not only visuals or videos. 

• Identify Common Issues: ChatGPT can help identify missing headings, vague links (“click 
here”), and unclear or incomplete instructions 

WHAT CHATGPT CANNOT DO 
ChatGPT does not add captions to videos, verify PDF accessibility or tagging, test materials with 
screen readers, or replace accessibility checkers. Faculty must still use available and built-in 
accessibility checkers and tools, as well as a manual check. 

BEST PRACTICES 
• Use ChatGPT to draft or revise content, then run an accessibility checker 
• Always manually review content for accuracy and clarity 
• Provide clear instructions when prompting ChatGPT 
• Use ChatGPT to support formatting and organization, not replace accessibility steps 

KEY TAKEAWAY 
ChatGPT can help prepare materials for accessibility by improving structure and clarity. 
Accessibility tools are still required to verify compliance. 
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APPENDIX C 

ACCESSIBLE CHEMICAL EQUATIONS IN BRIGHTSPACE 

CHEM I & CHEM II – STEP-BY-STEP INSTRUCTIONS 
Chemical equations must be typed using the Brightspace equation editor, not inserted as 
images, so screen readers can interpret them. 

STEP 1: Open The Brightspace HTML Editor 
1. Go to your content page, assignment, or announcement. 
2. Click Edit HTML (or open the content editor) 
3. Place your cursor where the equation should appear 

STEP 2: Insert An Equation 
1. Click the Insert Stuff (plug icon) or Equation Editor (∑ symbol) 
2. Select Equation Editor 
3. Choose LaTeX or the visual editor 

STEP 3: Type The Chemical Equation 
• Option A: Simple Visual Entry - Use the editor buttons to insert: 

o Subscripts (₂, ₃) 
o Superscripts (charges like ⁺, ⁻) 
o Arrows (→) 

• Option B: LaTeX (Recommended for Accuracy) Type directly: 
o Water formation: 2H_2 + O_2 \rightarrow 2H_2O 
o Ionic charge: Na^+ + Cl^- \rightarrow NaCl 
o Equilibrium (Chem II): N_2 + 3H_2 \rightleftharpoons 2NH_3 

• Then click Insert 

STEP 4: Add A Written Explanation (REQUIRED) 
Immediately below the equation, add a plain-language explanation. Example: 

• Equation: 2H₂ + O₂ → 2H₂O 
• Explanation: Two molecules of hydrogen react with one molecule of oxygen to form two 

molecules of water. 

STEP 5: Add Context For The Reaction (Especially Chem II) 
• For more advanced courses, include type of reaction (synthesis, equilibrium, redox); 

what is changing; and why it matters. Example: “This is a synthesis reaction where 
hydrogen and oxygen combine to form water.” 
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Step 6: Check Accessibility   
• Before publishing, make sure the equation is typed, not an image, ensure there is a 

written explanation below, avoid placing the equation inside an image or PDF, and run 
the Brightspace Accessibility Checker 

SPECIAL CASES IN CHEMISTRY 

Charges And Ions:   
• Use superscripts in the editor: 
• Example: Ca^{2+} + 2Cl^- \rightarrow CaCl_2 
• Add explanation: “Calcium ions with a +2 charge react with chloride ions to form 

calcium chloride.” 

Equilibrium (Chem Ii)   
• Use reversible arrow:   
• Example: N_2 + 3H_2 \rightleftharpoons 2NH_3 
• Explain: “This reaction is reversible and can proceed in both directions depending on 

conditions.” 

Reaction Conditions   
• Include conditions in text (not just symbols). Example: “Reaction occurs under high 

pressure and temperature.” 

WHAT TO AVOID 
• Screenshots of equations 
• Images of reactions 
• Handwritten notes uploaded as files 
• Equations without explanation 

QUICK CHECK 
Before posting, check the following: 

• Equation created in Brightspace editor 
• Subscripts and charges are correct 
• Explanation is included below 
• Reaction context is explained (if needed) 
• Accessibility checker has been run 

Key Takeaway: An accessible chemical equation includes a typed, structured equation, a plain-
language explanation, and a brief explanation of the reaction when needed. 
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ACCESSIBLE CHEMICAL EQUATIONS IN POWERPOINT (CHEM I & II) 
In PowerPoint, accessibility means converting symbolic information into structured, readable 
content. A chemical equation is only compliant if a student using a screen reader can 
understand the reaction, the charges, and the context. 

1. Creating The Equation (No Screenshots) 
• Do This: Use the built-in Equation Editor (Insert → Equation). 
• Why: Screen readers can "see" the structure of a typed equation, but they see a 

screenshot as a blank space. 
• LaTeX Shortcut: You can type LaTeX directly into the PowerPoint equation box (e.g., 

2H_2 + O_2 \rightarrow 2H_2O) and press enter to format it instantly. 

2. The Required Written Explanation 
• The Rule: Immediately below the equation, you must add a plain-language explanation. 
• Example: 

o Equation: $2H_2 + O_2 \rightarrow 2H_2O$   
o Explanation: "Two molecules of hydrogen react with one molecule of oxygen to 

form two molecules of water."   

3. Handling "Special Cases" In Chemistry 
• Charges and Ions: Ensure superscripts for charges (e.g., $Ca^{2+}$) are created using the 

editor's formatting, then explain them in text: "Calcium ions with a +2 charge..." 
• Equilibrium (Chem II): Use the reversible arrow ($\rightleftharpoons$) from the symbols 

menu. 
• Explanation: Add a note that "This reaction is reversible and can proceed in both 

directions..." 
• Reaction Conditions: If a reaction requires specific heat or pressure, include these as 

text, not just symbols over the arrow. 

4. Scientific Visuals (Graphs & Charts) 
• Graphs: Include a written explanation of the trends, relationships, and key results. 
• Example Alt-Text: "Line graph showing sales increasing from $10,000 in Q1 to $25,000 in 

Q4..." 
• Avoid: Posting a graph and simply saying "see graph above." 

CHEMISTRY FACULTY CHECKLIST 
• All equations are typed in the Equation Editor (no images/snips). 
• Subscripts and charges are correctly formatted. 
• A plain-language explanation is provided for every reaction. 
• The Selection Pane is ordered correctly (Title at the bottom). 
• No information is conveyed by color alone. 
• The Accessibility Checker returns "No issues."   
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APPENDIX D 

ADA ALT-TEXT GUIDELINES FOR IMAGES 
Cross-Disciplinary Guide for Meaningful Use 

PURPOSE 
In many courses, images function as instructional content, not just decoration. Alt-text ensures 
that students using screen readers have equitable access to visual information required for 
participation, comprehension, and assessment. Alt-text is not a caption. It is a concise verbal 
substitute for the essential visual information. 

CORE PRINCIPLES (ALL DISCIPLINES) 
• Describe what is visually present before interpreting meaning. 
• Prioritize details relevant to course learning objectives. 
• Match the level of detail to instructional purpose. 
• Be objective, precise, and concise. 
• Do not repeat information immediately stated before the image. 
• Separate description from extended analysis. 

TWO STRUCTURES DEPENDING ON COURSE TYPE 

I. STRUCTURE FOR ART, DESIGN, OR VISUAL ANALYSIS COURSES 
When the image is a primary text, students must have access to identifying and formal 
information. 

• Begin with: Artist (if known), Title, Date, Medium. 
• Follow with: Primary subject or figures; composition and spatial organization; key formal 

elements (color, light, line, texture, scale); and significant symbolic elements (when 
instructionally relevant). 

• Length Standards (Art Courses) 
o Simple images: 25–75 words 
o Major artworks: 75–125 words 
o Maximum: 150 words 

If longer analysis is required: Provide alt-text under 125 words, then include a separate “Long 
Description” in the lesson body. 

II. STRUCTURE FOR NON-ART COURSES (GENERAL ACADEMIC USE) 
In courses where images support instruction (e.g., literature, history, psychology, business, 
science, speech), the focus shifts from formal analysis to instructional relevance. 

• Begin with: What the image is (type and context). 
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• Follow with: Key visible elements necessary for understanding; labels or text embedded 
in the image; spatial relationships or comparisons; data trends (if chart/graph); and 
instructionally relevant features only. 

• Length Standards (General Courses) 
o Decorative images: 0–25 words (or alt="") if purely decorative 
o Instructional images: 25–75 words 
o Complex charts/diagrams: 40–100 words (plus explanation in body text) 

DISCIPLINE-SPECIFIC GUIDANCE 
• English: Characters shown; Setting or historical context; Visual details relevant to theme 

or tone 
• History / Social Sciences: Who or what is shown; Time period; Visible artifacts or 

documents; Spatial relationships 
• Science / STEM: Type of diagram or model; Labeled parts; Direction of movement or 

process; Data trends 
• Business / Communication: Chart type; Variables compared; Major trend or dominant 

category 

INCLUDE (ALL COURSES) 
• Identifiable people, objects, or setting 
• Relative positioning and scale 
• Dominant colors or contrasts if instructionally relevant 
• Labels or embedded text 
• Visible relationships central to learning objectives 

AVOID (ALL COURSES) 
• “Image of…” or “Picture of…” 
• Vague phrasing 
• Pure interpretation without visual evidence 
• Listing every minor detail 
• Repeating nearby captions verbatim 

SPECIAL CASES 
• Decorative Images: Use empty alt-text: alt="" 
• Charts / Graphs / Infographics: Provide concise alt-text plus full explanation in 

surrounding lesson text. 
• Maps: Describe region, orientation, labeled areas, and relevant spatial relationships. 
• Screenshots: Describe the interface elements students must interact with. 

EXAMPLE ART COURSE: Leonardo da Vinci, Mona Lisa, c. 1503–1506, oil on poplar panel. A half-
length portrait of a seated woman facing forward with her hands folded in her lap. She wears 
dark clothing and a thin veil. Her body forms a triangular composition, with soft transitions 
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between light and shadow modeling her face and hands. A hazy landscape of winding rivers and 
distant mountains appears behind her in muted blues and greens, creating depth and a calm 
but enigmatic atmosphere. 

EXAMPLE HISTORY: Black-and-white photograph of three women seated at a long factory 
workbench assembling machinery during World War II. They wear work uniforms and 
headscarves. Rows of identical parts extend across the table, emphasizing mass production. 
Industrial equipment fills the background. 

EXAMPLE BUSINESS CHART: Bar chart comparing quarterly sales for three product lines. 
Product A shows steady growth from Q1 to Q4. Product B declines slightly after Q2. Product C 
remains stable across all quarters. The vertical axis measures revenue in thousands of dollars. 

FACULTY QUALITY CHECK 
• Could a student who cannot see this image understand what is depicted? 
• Could they participate in discussion or complete the assignment? 
• Does the alt-text support course learning objectives? 
• Is the alt-text under 150 words? 
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APPENDIX E 

DIGITAL ACCESSIBILITY RESOURCE DIRECTORY 

INSTRUCTIONS AND TUTORIALS 

Microsoft Office (Word, PowerPoint, Excel, and Accessibility Checker) 
• Microsoft Accessibility Center: Accessibility Help & Learning 
• Accessibility Assistant and Checker: Improve accessibility in your documents with the 

Accessibility Assistant 
• Word Accessibility: Make your Word documents accessible 
• PowerPoint Accessibility:   

o Make your PowerPoint presentations accessible 
o Make slides easier to read by using the Reading Order pane 

• Excel Accessibility: Accessibility best practices with Excel spreadsheets 

Microsoft Teams and Stream 
• Teams Accessibility: Accessibility tools for Microsoft Teams 
• Stream Captions: Manage captions and transcripts in Microsoft Stream 

Adobe Acrobat and PDF Remediation 
• Adobe Accessibility Overview: Adobe Accessibility Principles 
• Acrobat Pro Instructions: Create and verify PDF accessibility 
• PDF Repair Workflow: Accessibility repair workflow for PDFs 
• OCR tutorial for scanned PDFs: How to Use Optical Character Recognition (OCR) in 

Adobe Acrobat Pro DC   

Zoom (Meetings and Cloud Recordings) 
• Zoom Accessibility Home: Accessibility 
• Captions and Transcription: Managing closed captioning and live transcription 

Google and YouTube 
• Google Accessibility Help: Accessibility Help 
• YouTube Captions: Manage and edit YouTube captions 
• Google Workspace: User guide to accessibility for Docs, Sheets, and Slides 

State and National Standards 
• Oklahoma ABLE Tech: Making Life Accessible to Oklahomans of All Ages and Abilities 

(Specialized accessibility training for Oklahoma higher education) 
• WebAIM (Accessibility in Mind): Comprehensive guides and a color contrast checker 
• W3C Web Accessibility Initiative: Making the Web Accessible (The international 

standards for WCAG compliance) 

https://www.google.com/search?q=https://support.microsoft.com/accessibility
https://www.google.com/search?q=https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4ab7-97fd-589c3f1e735b
https://www.google.com/search?q=https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4ab7-97fd-589c3f1e735b
https://www.google.com/search?q=https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf1333-6f94-4452-9ecc-d4948608e19c
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://support.microsoft.com/en-gb/office/make-slides-easier-to-read-by-using-the-reading-order-pane-863b5c1c-4f19-45ec-96e6-93a6457f5e1c?utm_source=chatgpt.com
https://www.google.com/search?q=https://support.microsoft.com/en-us/office/accessibility-best-practices-for-excel-spreadsheets-6bd6aa11-ec90-4497-9095-d3061733a411
https://support.microsoft.com/en-us/office/accessibility-tools-for-microsoft-teams-2d4009e7-1300-4766-87e8-7a217496c3d5
https://www.google.com/search?q=https://support.microsoft.com/en-us/office/generate-captions-and-a-transcript-for-a-microsoft-stream-classic-video-183416f4-1804-4f81-9b04-a55e10a266a1
https://www.adobe.com/accessibility.html
https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html
https://www.google.com/search?q=https://www.adobe.com/accessibility/products/acrobat/pdf-repair-workflow.html
https://kb.uwstout.edu/155829
https://kb.uwstout.edu/155829
https://www.google.com/search?q=https://zoom.us/accessibility
https://www.google.com/search?q=https://support.zoom.us/hc/en-us/articles/207279736-Managing-closed-captioning-and-live-transcription
https://support.google.com/accessibility
https://support.google.com/youtube/answer/2734698
https://support.google.com/accessibility/answer/6071002
https://www.okabletech.org/
https://webaim.org/
https://www.w3.org/WAI/
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• ITI VPAT Home Page: This is the official source for the latest VPAT 2.x templates 
(including the WCAG, Revised Section 508, and International editions). 

• Section508.gov - VPAT Resource: Provides a comprehensive guide for both buyers and 
vendors on how to request and create these reports. 

• Accessibility Conformance Report (ACR) 

Massachusetts Office on Disability 
• Creating Digital Documents series 
• Creating Accessible Tables (Module 3, Lesson 4) 

NOTE FOR FACULTY 
You may run the built-in accessibility checkers in Microsoft Office by going to Review > Check 
Accessibility. This tool automatically scans for missing alt-text, table formatting errors, and 
color contrast issues. For videos, remember that although Teams, Zoom, and YouTube generate 
captions automatically, you must review them for accuracy to meet full compliance standards. 

https://www.itic.org/policy/accessibility/vpat
https://www.section508.gov/sell/vpat/
https://www.section508.gov/sell/acr/
https://youtube.com/playlist?list=PLsiz0GxiqA2f88B5u9B6uqHDsP3ArEYgK&si=yg_YHlMpMddo8odN
https://youtu.be/Y5rUaDL-IDc?si=FpuO-S1DDGc3LOiH
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